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Basic HTML Codes

GENERAL (all HTML documents should have these)

Document Type <HTML></HTML> (beginning and end of file)

Title <TITLE></TITLE> (must be in header)

Header <HEAD></HEAD> (descriptive info, such as title) 

Body <BODY></BODY> (bulk of the page)

STRUCTURAL DEFINITION (appearance controlled by the browser's preferences)

Heading <H?></H?> (the spec. defines 6 levels)

Align Heading <H? ALIGN=LEFT|CENTER|RIGHT></H?>

Division <DIV></DIV>

Align Division <DIV ALIGN=LEFT|RIGHT|CENTER|JUSTIFY></DIV>

Block Quote <BLOCKQUOTE></BLOCKQUOTE> (usually indented)

Emphasis <EM></EM> (usually displayed as italic)

Strong Emphasis <STRONG></STRONG> (usually displayed as bold)

Citation <CITE></CITE> (usually italics)

Code <CODE></CODE> (for source code listings)

Sample Output <SAMP></SAMP>

Keyboard Input <KBD></KBD>

Variable <VAR></VAR>

Definition <DFN></DFN> (not widely implemented)

Author's Address <ADDRESS></ADDRESS>

Large Font Size <BIG></BIG>

Small Font Size <SMALL></SMALL>

PRESENTATION FORMATTING (author specifies text appearance)

Bold <B></B>

Italic <I></I>

N3.0b Underline <U></U> (not widely implemented yet) 

Strikeout <STRIKE></STRIKE> (not widely implemented yet)

N3.0b Strikeout <S></S> (not widely implemented yet) 

Subscript <SUB></SUB>

Superscript <SUP></SUP>

Typewriter <TT></TT> (displays in a monospaced font) 

Preformatted <PRE></PRE> (display text spacing as-is) 

Width <PRE WIDTH=?></PRE> (in characters)

Center <CENTER></CENTER> (for both text and images) 



N1.0 Blinking <BLINK></BLINK>

Font Size <FONT SIZE=?></FONT> (ranges from 1-7)

Change Font Size <FONT SIZE="+|-?"></FONT>

N1.0 Base Font Size <BASEFONT SIZE=?> (from 1-7; default is 3)

Font Color <FONT COLOR="#$$$$$$"></FONT>

N3.0b Select Font <FONT FACE="***"></FONT>

N3.0b Multi-Column <MULTICOL COLS=?></MULTICOL>

N3.0b Column Gutter <MULTICOL GUTTER=?></MULTICOL> 

N3.0b Column Width <MULTICOL WIDTH=?></MULTICOL>

N3.0b Spacer <SPACER>

N3.0b Spacer Type <SPACER TYPE=horizontal|vertical|block> 

N3.0b Size <SPACER SIZE=?>

N3.0b Dimensions <SPACER WIDTH=? HEIGHT=?>

N3.0b Alignment <SPACER ALIGN=left|right|center>

LINKS AND GRAPHICS

Link Something <A HREF="URL"></A>

Link to Target <A HREF="URL#***"></A> (if in another document)

<A HREF="#***"></A> (if in current document)

N2.0 Target Window <A HREF="URL" TARGET="***"></A> 

Define Target <A NAME="***"></A>

Display Image <IMG SRC="URL">

Alignment <IMG SRC="URL" ALIGN=TOP|BOTTOM|MIDDLE|LEFT|RIGHT> 

Alternate <IMG SRC="URL" ALT="***"> (if image not displayed) 

Dimensions <IMG SRC="URL" WIDTH=? HEIGHT=?> (in pixels)

Border <IMG SRC="URL" BORDER=?> (in pixels)

Runaround Space <IMG SRC="URL" HSPACE=? VSPACE=?> (in pixels)

N1.0 Low-Res Proxy <IMG SRC="URL" LOWSRC="URL">

Imagemap <IMG SRC="URL" ISMAP> (requires a script)

Imagemap <IMG SRC="URL" USEMAP="URL">

Map <MAP NAME="***"></MAP> (describes the map)

Section <AREA SHAPE="RECT" COORDS=",,," HREF="URL"|NOHREF> 

N1.1 Client Pull <META HTTP-EQUIV="Refresh" CONTENT="?; URL=URL">

N2.0 Embed Object <EMBED SRC="URL"> (insert object into page)

N2.0 Object Size <EMBED SRC="URL" WIDTH=? HEIGHT=?>

DIVIDERS



Paragraph <P></P> (closing tag often unnecessary)

Align Text <P ALIGN=LEFT|CENTER|RIGHT></P>

Line Break <BR> (a single carriage return)

Clear Textwrap <BR CLEAR=LEFT|RIGHT|ALL>

Horizontal Rule <HR>

Alignment <HR ALIGN=LEFT|RIGHT|CENTER>

Thickness <HR SIZE=?> (in pixels)

Width <HR WIDTH=?> (in pixels)

Width Percent <HR WIDTH="%"> (as a percentage of page width) 

Solid Line <HR NOSHADE> (without the 3D cutout look)

N1.0 No Break <NOBR></NOBR> (prevents line breaks) 

N1.0 Word Break <WBR> (where to break a line if needed)

LISTS (lists can be nested)

Unordered List <UL><LI></UL> (<LI> before each list item)

Compact <UL COMPACT></UL>

Bullet Type <UL TYPE=DISC|CIRCLE|SQUARE> (for the whole list)

<LI TYPE=DISC|CIRCLE|SQUARE> (this & subsequent)

Ordered List <OL><LI></OL> (<LI> before each list item)

Compact <OL COMPACT></OL>

Numbering Type <OL TYPE=A|a|I|i|1> (for the whole list)

<LI TYPE=A|a|I|i|1> (this & subsequent)

Starting Number <OL START=?> (for the whole list)

<LI VALUE=?> (this & subsequent)

Definition List <DL><DT><DD></DL> (<DT>=term, <DD>=definition)

Compact <DL COMPACT></DL>

Menu List <MENU><LI></MENU> (<LI> before each list item)

Compact <MENU COMPACT></MENU>

Directory List <DIR><LI></DIR> (<LI> before each list item)

Compact <DIR COMPACT></DIR>

BACKGROUNDS AND COLORS

Tiled Bkground <BODY BACKGROUND="URL">

Bkground Color <BODY BGCOLOR="#$$$$$$"> (order is red/green/blue)

Text Color <BODY TEXT="#$$$$$$">

Link Color <BODY LINK="#$$$$$$">

Visited Link <BODY VLINK="#$$$$$$">



Active Link <BODY ALINK="#$$$$$$">

SPECIAL CHARACTERS (these must all be in lower case)

Special Character &#?; (where ? is the ISO 8859-1 code)

< &lt;

> &gt;

& &amp;

" &quot;

Registered TM &#174;

Registered TM &reg;

Copyright &#169;

Copyright &copy;

Non-Breaking Spc &nbsp

FORMS (generally require a script on your server)

Define Form <FORM ACTION="URL" METHOD=GET|POST></FORM> 

N2.0 File Upload <FORM ENCTYPE="multipart/form-data></FORM>

Input Field <INPUT TYPE="TEXT|PASSWORD|CHECKBOX|RADIO|

IMAGE|HIDDEN|SUBMIT|RESET">

Field Name <INPUT NAME="***">

Field Value <INPUT VALUE="***">

Checked? <INPUT CHECKED> (checkboxes and radio boxes)

Field Size <INPUT SIZE=?> (in characters)

Max Length <INPUT MAXLENGTH=?> (in characters)

Selection List <SELECT></SELECT>

Name of List <SELECT NAME="***"></SELECT>

# of Options <SELECT SIZE=?></SELECT>

Multiple Choice <SELECT MULTIPLE> (can select more than one) 

Option <OPTION> (items that can be selected)

Default Option <OPTION SELECTED>

Input Box Size <TEXTAREA ROWS=? COLS=?></TEXTAREA> 

Name of Box <TEXTAREA NAME="***"></TEXTAREA>

N2.0 Wrap Text <TEXTAREA WRAP=OFF|VIRTUAL|PHYSICAL></TEXTAREA>

TABLES

Define Table <TABLE></TABLE>

Table Border <TABLE BORDER></TABLE> (either on or off) 

Table Border <TABLE BORDER=?></TABLE> (you can set the value)



Cell Spacing <TABLE CELLSPACING=?>

Cell Padding <TABLE CELLPADDING=?>

Desired Width <TABLE WIDTH=?> (in pixels)

Width Percent <TABLE WIDTH=%> (percentage of page)

Table Row <TR></TR>

Alignment <TR ALIGN=LEFT|RIGHT|CENTER

VALIGN=TOP|MIDDLE|BOTTOM>

Table Cell <TD></TD> (must appear within table rows) 

Alignment <TD ALIGN=LEFT|RIGHT|CENTER

VALIGN=TOP|MIDDLE|BOTTOM>

No linebreaks <TD NOWRAP>

Columns to Span <TD COLSPAN=?>

Rows to Span <TD ROWSPAN=?>

N1.1 Desired Width <TD WIDTH=?> (in pixels)

N1.1 Width Percent <TD WIDTH="%"> (percentage of table)

N3.0b Cell Color <TD BGCOLOR="#$$$$$$">

Table Header <TH></TH> (same as data, except bold centered)

Alignment <TH ALIGN=LEFT|RIGHT|CENTER

VALIGN=TOP|MIDDLE|BOTTOM>

No Linebreaks <TH NOWRAP>

Columns to Span <TH COLSPAN=?>

Rows to Span <TH ROWSPAN=?>

N1.1 Desired Width <TH WIDTH=?> (in pixels)

N1.1 Width Percent <TH WIDTH="%"> (percentage of table)

N3.0b Cell Color <TH BGCOLOR="#$$$$$$">

Table Caption <CAPTION></CAPTION>

Alignment <CAPTION ALIGN=TOP|BOTTOM> (above/below table) 

FRAMES (define and manipulate specific regions of the screen)

N2.0 Frame Document <FRAMESET></FRAMESET> (instead of <BODY>)

N2.0 Row Heights <FRAMESET ROWS=,,,></FRAMESET> (pixels or %)

N2.0 Row Heights <FRAMESET ROWS=*></FRAMESET> (* = relative size)

N2.0 Column Widths <FRAMESET COLS=,,,></FRAMESET> (pixels or %)

N2.0 Column Widths <FRAMESET COLS=*></FRAMESET> (* = relative size)

N3.0b Borders <FRAMESET FRAMEBORDER="yes|no">

N3.0b Border Width <FRAMESET BORDER=?>



N3.0b Border Color <FRAMESET BORDERCOLOR="#$$$$$$">

N2.0 Define Frame <FRAME> (contents of an individual frame) 

N2.0 Display Document <FRAME SRC="URL">

N2.0 Frame Name <FRAME NAME="***"|_blank|_self|_parent|_top> 

N2.0 Margin Width <FRAME MARGINWIDTH=?> (left and right margins)

N2.0 Margin Height <FRAME MARGINHEIGHT=?> (top and bottom margins)

N2.0 Scrollbar? <FRAME SCROLLING="YES|NO|AUTO">

N2.0 Not Resizable <FRAME NORESIZE>

N3.0b Borders <FRAME FRAMEBORDER="yes|no">

N3.0b Border Color <FRAME BORDERCOLOR="#$$$$$$">

N2.0 Unframed Content <NOFRAMES></NOFRAMES> (for non-frames browsers)

JAVA

Applet <APPLET></APPLET>

File Name <APPLET CODE="***">

Parameters <APPLET PARAM NAME="***">

Location <APPLET CODEBASE="URL">

Identifier <APPLET NAME="***"> (for references)

Alt Text <APPLET ALT="***"> (for non-Java browsers)

Alignment <APPLET ALIGN="LEFT|RIGHT|CENTER">

Size <APPLET WIDTH=? HEIGHT=?> (in pixels)

Spacing <APPLET HSPACE=? VSPACE=?> (in pixels)

MISCELLANEOUS

Comment <!-- *** --> (not displayed by the browser)

Prologue <!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 3.2//EN"> 

Searchable <ISINDEX> (indicates a searchable index)

Prompt <ISINDEX PROMPT="***"> (text to prompt input)

Send Search <A HREF="URL?***"></a> (use a real question mark)

URL of This File <BASE HREF="URL"> (must be in header)

N2.0 Base Window Name <BASE TARGET="***">(must be in header) 

Relationship <LINK REV="***" REL="***" HREF="URL"> (in header)

Meta Information <META> (must be in header)

Style Sheets <STYLE></STYLE> (not widely supported yet)

Scripts <SCRIPT></SCRIPT> (not widely supported yet) 



Color to HEX

The Color to HEX function eliminates the need to know HEX codes.    Find the desired color in the color grid and CuteHTML does 
the rest. 

1 From the Menu Bar, click Tools/Color to Hex.

2 To insert a basic color HEX code:
Click on a basic color, then click 'OK' to insert the HEX code for the selected color into your document. 

3 To insert a custom color HEX code:
Click a basic color then click and drag the 4-point black cursor (usually at the top or bottom portion of the color grid) through the 
color grid.    When the Color|Solid block shows the desired color, click 'OK' to insert the HEX codes into your document.

Related Topics:
Basic HTML Codes



Close a HTML Document

To close an open HTML document

1 From the Menu Bar, click File/Close.

If your document has unsaved changes, a prompt to save your document will appear.
Click 'Yes' to save the document.
Click 'No' to exit without saving the document or changes. 
Click 'Cancel' to return to the document without saving the document or changes.

If the document was saved before closing, the document will leave your screen.

To close all open HTML documents

1 From the Menu Bar, click File/Close All.

All open documents will close one-by-one.    If changes have been made, you will be prompted to save the document before 
closing.

NOTE:    Each open document is represented by a tab along the bottom of the HTML screen.    Red lettering indicates the document 
has not been saved.    Lettering becomes black when the document is saved.

Related Topics:
Save an HTML Document
Close Command (Control Menu)



Create a HTML Document

CuteHTML opens to a new document window with a basic HTML template. 

1 Build your document by adding code to the template.    See Using Tag Tips and Basic HTML Codes for reference.

2 Use Tag Tips to display HTML codes for building your document.    To access the tags, press 'shift' then 'left caret (the comma 
key).    The tag tips box displays the tags in alphabetical order.    Scroll down to your selection and double-click to insert.    
Subsequent boxes will display until the selected code is complete.

To open additional new documents:

1 From the Menu Bar, click File/New.

2 Continue with steps 1 and 2 above.
 
Tips

Multiple documents can be open at one time.    Click on one of the tabs at the bottom of the screen to move from one document to 
another.

Related Topics:
Status Bar
Basic HTML Codes
Save an HTML Document
Tag Tips-Settings
Using Tag Tips
Color to HEX
Editor Settings



Display Cute HTML Toolbar

The Toolbar features icons such as 'print', 'copy', 'paste', etc. normally found on any windows software.    These icons are located at 
the left end of the Toolbar.    The Join HitBOX icon located in the middle is specific to CuteHTML.      The last eight icons on the 
CuteHTML Toolbar represent tags frequently used in HTML documents.    Place your cursor over any image to see the tag name and 
click to insert. 

The HTML tags on the Toolbar are defined as follows:

Bold Position your cursor at the beginning point of bold text in your document. 
Click the Bold icon. 
Type the text to appear in bold. 
Use the right arrow key to move past the ending bold tag when finished.

Italics Position your cursor at the beginning point of italics text in your document.
Click the Italics icon.
Type the text to appear in italics.
Use the right arrow key to move past the ending italics tag when finished.

Underline Position your cursor at the beginning point of underlined text in your document.
Click the Underline icon.
Type the text to appear underlined.
Use the right arrow key to move past the ending underline tag when finished.

Anchor Position your cursor at the point you wish to insert an anchor.
Click the Anchor icon.
Type the requested information in the anchor dialog box. 
Click the 'OK' button.

Image Position your cursor at the point you wish to insert an image.
Click the Image icon.
Fill in or browse for the source of the image and complete other fields in the dialog box.
Click the 'OK' button.    See Inserting Images for more detailed information.

Font Position your cursor at the point you wish to change the font, font color or size.
Click the Font icon.
Change the font, color or size for text.    Use the down arrows at end of each field to select.
Click the 'OK' button.

Comment Position your cursor at the point you wish to insert a comment.
Click the 'Comment' icon.
Begin typing your comment.  Comments do not show when viewed with a browser.

The CuteHTML Toolbar can be toggled between being viewed or hidden.    The default is 'View'.

1 To Hide the CuteHTML Toolbar:
From the Menu Bar, click View/Tag Toolbar.

2 To View the CuteHTML Toolbar:
From the Menu Bar, click View/Tag Toolbar.



Display Cute HTML Status Bar

The Status Bar displays information about open HTML documents.    CuteHTML opens with the Status Bar in view.

1 To hide the Status Bar: 
From the Menu Bar, click View/Status Bar. 

2 To view the Status Bar:
From the Menu Bar, click View/Status Bar.

NOTE:    This function works as a toggle.    Click to view--click again to hide.

Related Topic:
Status Bar



Edit a HTML Document

Documents may be edited by adding, deleting or moving text.

Insert Text Position the cursor at the point you want to add text and click.    Begin typing.

Delete Text Position the cursor at the beginning of the text to be deleted.

Click and hold down the left mouse button as you drag the mouse to the right, highlighting the text to be 
deleted.

Press the delete button on your keyboard. 

Move Text Position the cursor at the beginning of the text to be moved.

Click and hold down the left mouse button as you drag the mouse to the right, highlighting the text to be 
moved. 

On the Edit menu, click 'Cut'.

Position the cursor at the new location for the text. 

Click with the left mouse button.

On the Edit menu, click 'Paste'.

Related Topics:
Open an HTML Document
Basic HTML Codes
Save a HTML Document
Print a HTML Document
Close a HTML Document
Tag Tips Settings
Using Tag Tips
Color to HEX



Open a HTML Document

To open an HTML document
  
1 From the Menu Bar, click File/Open.

2 Click the down arrow at the end of the "Look In" field and find the directory where the file is located.

3 Double-click on the directory name.    When the file in the chosen directory appears, double-click the file you wish to bring to the 
screen.

4 Begin editing the document.

Tips

Each open document is represented by a tab along the bottom of the screen.    Multiple documents can be open at one time.    To 
move between open documents, click the tab of the document you wish to bring to view. 

 NOTE:    Unsaved document names show in red lettering.

Related Topics: 
Status Bar
Basic HTML Codes
File/Recent File



Print a HTML Document

CuteHTML uses standard Windows® printing menus.

To change printer setup (such as printer, paper size or orientation):

1 From the Menu Bar, click File/Print Setup.

2 Use the down arrows to change options.    Click 'OK' to accept.

To see a print preview:

1 From the Menu Bar, click File/Print Preview.

2 From the preview screen, click 'Print' to send the document to the printer or click 'Close' to return to the document screen.

To print a document:

1 From the Menu Bar, click File/Print.

Tips

While a document is printing, a printer icon appears next to the clock on the taskbar. When this icon disappears, your document has 
finished printing.

Related Topics:
Close a HTML Document
Save a HTML Document



Save a HTML Document

To save an HTML document
  
1 On the File menu, click one of the following:

Save Saves and allows you to name the current document if it is untitled.

Save As Allows you to save the current document with a different name or extension.

Save All Allows you to save, one after another, all open documents.

Save to Remote Saves the document back to its original location on the server.  This feature can only be used 
when CuteHTML is accessed from CuteFTP.

Save all to Remote Saves all open documents back to their original location on the server.    This feature can only be 
used when CuteHTML is accessed from CuteFTP.

2 Type the name of the document in the 'File Name' field.

3 Click the 'Save' button to save the document.

Related Topic: 
Close a HTML document



Settings

Use the settings option to change defaults for editing documents, selecting tag colors, choosing a different default browser, setting 
locations for snippets and Java scripts, and setting parameters for displaying drop-down code menus for use in building your HTML 
document. 

1 From the Menu Bar, click Tools/Settings. 

Related Topics:
Editor Settings
Color Settings
Directory Settings
Tag Tip Settings



Status Bar

The Status Bar, located at the bottom of the CuteHTML screen contains tools and information to help users navigate through a 
document or through multiple documents. 

Arrow Buttons
Use the arrow buttons at the left end of the status bar to move through your document.    Click the right arrow to move forward one 
page at a time.    Click the left arrow to move back one page at a time.    Arrows only function for multiple page documents.

Tabs
Tabs displayed on the status bar represent open documents.    Click on a tab to move to a different document.    Multiple documents 
may be open at one time.    Tabs with document names in red indicate an unsaved document.

Line/Pages Indicator
The two numbers at the far right of the status line represent the line position and number of lines in the document.    The left number 
represents the line at which your cursor is located.    The right number represents the number of lines in your document.



Tool Bar

The Toolbar appears beneath the Menu Bar.    Each icon represents a function also accessible through the Menu Bar.    The icons on 
the toolbar represent a shortcut to frequently-used functions.    Place your mouse pointer over an icon to to display a tag describing 
the feature.

Related Topic:
Tag Tool Bar



View in Browser

Users may view results of HTML coding at any time while working on a document by doing the following:

1 From the Menu Bar, click Tools/View in browser.
The default browser or selected browser will be launched.

2 Close the browser to return to your HTML document.

Related Topics:
Edit a HTML Document
Basic HTML Codes
Color to HEX



CuteHTML Help Index

How To ...
Close a Document
Change Color
Copy Text
Create a New Document
Cut Selected Text
Display Status Bar
Display Toolbar
Find Text
Replace Text
Insert an Image
Print a Document
Save a Document
Open a Document
Paste Text
Change Settings
Join HitBOX

Commands
Edit Menu
View Menu
Help Menu



View menu commands

The View menu offers the following commands:

Tool Bar Shows or hides the program tool bar.
Status Bar Shows or hides the status bar.
Tag Tool Bar Shows or hides the tag tool bar.



Help menu commands

The Help menu offers the following commands which provide assistance with this application: 

About Gives information about the version of software.

Help Topics Opens a help file in standard windows format with a contents, index and find tab.

Related Topic:
Using Help



File New command

Use this command to create a new document in CuteHTML. 

You can open an existing document with the Open Command.

Shortcuts
Press the new document icon on the Tool Ba or press Ctrl plus N



File Open command

Use this command to open an existing document in a new window.    You can open multiple documents at once.    Use the Window 
menu to switch among the multiple open documents. 

You can create new documents with the New Command.

Shortcuts
Press the open file icon on the Taskbar or press Ctrl plus O



File Open dialog box

The following options allow you to specify which file to open:

File Name
select the filename you want to open. 

List Files of Type
The default type is .htm, .html.    Files of these types will be displayed in the 'File Name' field.    Use the down arrow to view other 
selections including 'all files' and click one to select.

Drives
The drive defaults to the location of the CuteHTML folder.    To select another drive, click the down arrow at the end of the field and 
double click on a different drive. 

Directories
The directory defaults to CuteHTML.    To change the directory, click the down arrow at the end of the field and double click the 
directory where your files are located.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



File Close command

Use this command to close all windows in the active document. It is recommended that all documents be saved before closing a 
document so that changes made since the last time the document was saved will not be lost.    Before closing an untitled document, 
CuteHTML will display the Save As dialog box and suggest that you name and save the document.

You can also close a document by using the Close icon on the document's window.    The close icon is located at the far left end of 
the program title bar and is usually depicted by the program icon    Click the icon to see the drop-down menu.



File Save command

Use this command to save the active document to its current name and directory.    When you save a document for the first time, 
CuteHTML displays the Save As dialog box so you can name your document.    If you want to change the name and directory of an 
existing document before you save it, choose the Save As command.

Shortcuts
Press the save icon on the Toolbar or press Ctrl plus S on the keyboard.



File Save As command

Use this command to save and name the active document.    CuteHTML displays the Save As dialog box so you can name your 
document. 

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you are about to save:

File Name
Type a new file name to save a document with a different name.    CuteHTML adds the extension you specify in the Save File As 
Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



File Exit command

Use this command to end your CuteHTML session.    You can also use the Close command on the application Control menu.    
CuteHTML prompts you to save documents with unsaved changes.

Shortcuts
Double click the application's Control menu button located in the upper left-hand window of the program window or press Alt plus 
F4.



Cut command (Edit menu)

Use this command to remove selected text from the document and place it on the Clipboard.    This command is unavailable if there 
is no data currently selected.

NOTE:    Cutting data to the Clipboard replaces the contents previously stored there.

Shortcuts
Press the cut icon on the Toolbar or press Ctrl plus X

Related Topic:
Paste Command (Edit menu)



Copy command (Edit menu)

Use this command to copy selected data onto the Clipboard.    This command is unavailable if there is no data currently selected.

NOTE:    Copying data to the Clipboard replaces the contents previously stored there.

Shortcuts
Use the copy command on the Toolbar or press Ctrl plus C

Related Topic:
Paste Command (Edit Menu)



Paste command (Edit menu)

Use this command to insert a copy of the Clipboard contents at the position of the cursor.    This command is unavailable if the 
Clipboard is empty.

Shortcuts
Press the Clipboard icon on the Toolbar or press Ctrl plus V on the keyboard.

Related Topics:
Cut Command 
Copy Command



View Toolbar command

Use this command to display and hide the Toolbar, which includes buttons for some of the most common commands in CuteHTML, 
such as File/Open.    A check mark appears next to the menu item when the Toolbar is displayed.

See Display CuteHTML Toolbar  for help on using the Toolbar.



View Status Bar Command

Use this command to display and hide the Status Bar, which describes the action to be executed by the selected menu item or 
depressed Toolbar button, and keyboard latch state. A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of CuteHTML.



Title Bar

The title bar, located along the top of a window, contains the application and document names.

To move the window, click on the title bar and drag it to a new location.    Note: You can also move dialog boxes by clicking and 
dragging their title bars as well.

A title bar may contain the following elements:

Application Control-menu button - Located in the upper left corner of the title bar, this program icon is used to close, minimize, 
maximize, etc. the application

Name of the application - The name of the program you have open appears on the Title Bar.

Name of the document - If saved, the name of your document will appear next to the name of the application on the Title Bar.    
Unsaved documents show as 'Untitled1'.

Minimize program button - Llocated on the far right side of the Title Bar, this left button leaves the program open but moves the 
program out of desktop view.    Look for the program icon on your status bar along the bottom of your desktop.

Maximize program button - Located on the far right side of the Title Bar, this middle button expands the program to a full screen.    
Click the button again (restore) to return to its original size.

Restore program button - When the program is maximized, this icon appears in the middle of the three buttons located at the end 
of the title bar.

Close program button - Located on the far right side of the title bar, this right button closes the program.

Document Control-menu button - Located to the left of 'File' on the menu line, this icon is used to close, minimize, maximize, etc 
the document.

Minimize document button - Icon located on the far right side of the Menu Bar, this left button leaves the document open but 
moves the document out of desktop view.    Look for the document icon at the bottom of your program window.

Restore document button - When the document is maximized, this button appears in the middle of the three buttons located at the 
end of the Title Bar.

Close document button - Located on the far right side of the Menu Bar, this right button closes the document.



Scroll bars

Displayed at the right and bottom edges of the document window on documents that are too large to appear in the screen window.    
The scroll boxes inside the scroll bars indicate your vertical and horizontal location in the document.    You can use the mouse to 
scroll to other parts of the document.



System Minimize Command

Use this command to reduce the CuteHTML window to an icon.

Shortcut
Click the minimize icon on the Title Bar or press Alt plus F9 on the keyboard.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    CuteHTML determines which window is next according to the 
order in which you opened the windows.

Shortcut

Keys: Ctrl+F6

Related Topic:
Display CuteHTML Status Bar



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    CuteHTML determines which window is previous according to 
the order in which you opened the windows.

Shortcut

Keys: SHIFT+Ctrl+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

As an alternate to using File/Close, double-click the Control-menu box depicted by the program icon at the far left end of the 
program title bar.

Note:    The Close command closes only one window at a time.    Use File/Close if you have multiple windows open.

Shortcuts
Keys: Ctrl+F4 closes a document window

Alt+F4 closes the CuteHTML window or dialog box

Related Topic:
Close a HTML Document



Edit Find Command

CuteHTML uses the standard windows find/replace utility to locate text.

1 From the menu Bar, click Edit/Find / Replace

To find text only: Type in the word or words you wish to find in the "Search For" field.

Click the 'Find' button.

The cursor will be positioned at the word or words found by the search.

To find and replace: Type in the word or words you wish to change in the "Search For" field.    Type in the new word or 
words in the "Replace With" field.

Select on option under "Where to Search" in the lower left part of the screen.

Click in the open box next to "Match Case" if you want the system to match capitalization.    (A check 
mark in the box indicates matching will occur.)

Click the 'Find' button.

The first match will be located and replaced.    To continue to search and replace throughout the 
document, click the 'Find Next' button for each instance.

WARNING:
Because it replaces all occurrences, be very careful when choosing the replace option.    For 
example, if you want to change all occurrences of 'one' to '1', it will also change words like 
'everyone' to 'every1'.

Related Topic:
Replace Command



Find Dialog

Find dialog box

"Search For" field: Type in the word or words you wish to find.

"Replace With: field: Type in the word or words to replace previous word or words found by the search.

"Where to search": Options include searching active documents only or all open documents.

Click in the circle to the left of the option you wish to select.

"Match Case": A check mark in the box indicates the system will match case (capitalization) during the search. 

An open box indicates the system will ignore case (capitalization) during the search.

Click in the box to insert or remove the check mark.



Edit Replace Command

CuteHTML uses the standard windows find/replace utility to locate and replace text.

1 From the Menu Bar, click Edit/Find / Replace.

To replace: Type in the word or words you wish to replace in the "Search For" field.    Type in the new word or
words in the "Replace With" field.

Select on option under "Where to Search" in the lower left part of the screen.

Click in the open box next to "Match Case" if you want the system to match capitalization.    (A check mark in the 
box indicates matching will occur.)

Click the 'Find' button.

The first match will be located and replaced.    To continue to search and replace throughout the document, click 
the 'Find Next' button for each instance.

WARNING:
Because it replaces all occurrences, be very careful when choosing the replace option.    For example, if 
you want to change all occurrences of 'one' to '1', it will also change words like 'everyone' to 'every1'.

Related Topic:
Find Command



Replace Dialog

Fields in the replace dialog box are defined as follows:

"Search For" Type in the word or words you wish to replace in the "Search For" field.

"Replace With" Type in the new word or words in the "Replace With" field.

"Where to Search" Select an option.

"Match Case" Click in the open box next to "Match Case" if you want the system to match capitalization.    (A check 
mark in the box indicates matching will occur.)

"Find" Initiates the search.

"Find Next" Finds the next matching word or words.



No Help Available

No help is available for this area of the window.



No Help Available_1

No help is available for this message box.



File Print command

Use this command to print a document.      This command presents a print dialog box, where you may specify the range of pages to 

be printed, the number of copies, the destination printer, and other printer setup options.

Shortcuts

Press the print icon on the Toll Bar or press Ctrl plus P.



Print dialog box

The following options allow you to specify how the document should be printed:

Printer

This is the active printer and printer connection.    Choose the Setup option to change the printer and printer connection.

Setup

Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range

Specify the pages you want to print:

All Prints the entire document.

Selection Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.

Copies

Specify the number of copies you want to print for the above page range.

Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.

Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to produce.



Print Progress Dialog

The Printing dialog box is shown during the time that CuteHTML is sending output to the printer.    The page number indicates the 

progress of the printing.

To abort printing, choose Cancel.



File Print Preview command

Use this command to display the active document as it would appear when printed.    When you choose this command, the main 

window will be replaced with a print preview window in which one or two pages will be displayed in their printed format.    The Print 

Preview Toolbar offers you options to view either one or two pages at a time; move back and forth through the document; zoom in 

and out of pages; and initiate a print job.



Print preview toolbar

The print preview Toolbar offers you the following options:

Print

Bring up the print dialog box to start a print job.

Next Page

Preview the next printed page.

Prev Page

Preview the previous printed page.

One Page / Two Page

Preview one or two printed pages at a time.

Zoom In

Take a closer look at the printed page.

Zoom Out

Take a larger look at the printed page.

Close

Return from print preview to the editing window.



File Print Setup command

Use this command to select a printer and a printer connection.    This command presents a Print Setup dialog box, where you 

specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.

Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific Printer option and select one of the current 

installed printers shown in the box.    You install printers and configure ports using the Windows® Control Panel. 

Orientation

Choose Portrait or Landscape.

Paper Size

Select the size of paper that the document is to be printed on.

Paper Source

Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options

Displays a dialog box where you can make additional choices about printing, specific to the type of printer you have selected.

Network...

Choose this button to connect to a network location, assigning it a new drive letter.



Editor Settings

CuteHTML installs with standard settings which may be changed to each user's preference.

1 From the Menu Bar, click Tools/Settings

2 Click the Editor tab to change program defaults for any of the following:

Edit New Document Template

The existing template may be changed to fit each user's needs.    Changes to the template will affect all new documents created 
from that point forward. 

1 Click the 'Edit New Document Template' button.

2 Position your cursor at point you wish to edit and 'Click' with the left mouse button.  (Notice the entire template is highlighted 
and will be deleted if you start typing before you click to refocus the cursor.)

3 Make your changes and click 'OK' to save or 'Cancel' to retain the original template.

Choose Font Editor

The default type, style and size may be changed for the current and future documents..

1 Click the 'Choose Font for editor' button.

2 Select a new type, style and size.

3 Click 'OK' to save the new settings or 'Cancel' to retain the default settings.

Right Click Shell Integration for these File Types

By default, documents with html, htm or txt extensions can be accessed through a right click mouse action from Windows® 
Explorer.      Users may add to the default file types by adding other document extensions at the end of the field.

1 To turn off the Right Click Shell Integration feature:    Click the arrow next to the 'Right click shell integration for folders' 
field.    (The check mark will disappear indicating the feature is inactive.)

Allow Editing Beyond End of Line

Active by default, this feature enables the user to click in any open area in the HTML document and insert text or graphics. 

1 To turn off the 'Allow Editing Beyond End of Line' feature:    Click the check mark next to the 'Allow editing beyond end of 
line' field.    (The check mark will disappear indicating the feature is inactive.)

Show Line Numbers

CuteHTML shows line numbers for better code management. 

1 To hide line numbers, click the check mark next to the 'Show line numbers' field.

Word Wrap

CuteHTML defaults to wrap lines of text for complete document visibility. 

1 To turn off word wrap, click the check mark next to the 'Word Wrap' field.

NOTE:    Each of the features above may be toggled from active to inactive.    Since the features above default to active, click to 
make them inactive, click again to make active, etc.



Colors-Settings

Tag and comment colors may be changed to user preference.    Documents previously created as well as new documents will 
assume the new color settings as they are viewed in the CuteHTML program.

1 From the Menu Bar, click Tools/Settings. 

2 On the Settings dialog box, click the 'Colors' tab to display current colors for tags and comments. 

3 Move to the tag or comment you wish to change and click the down arrow at the end of the field.

4 Select a new color from the palette.

5 Click 'OK' to accept the change and return to the HTML document window.

Check the [Use System Settings]  box to use the Windows default background and text colors. Unchecking this box will allow for 
selecting these colors manually.



Directories-Settings

Default browser and directory paths may be changed to user preference as follows:

1 From the Menu Bar, click Tools/Settings. 

2 Click the 'Directories' tab.

3 To select another browser:  Click the check mark in the 'Use default browser' field to enable browser selection.    Next, type in 
the new path or click on the 'Browse' button to find the path of the executable file to your browser.

4 To change the directories for the snippets or Java scripts:    Type in the new path or click the 'Browse' button to find the new 
location



Tag Tips-Settings

The CuteHTML Tag Tips feature is active when the program is installed.    To inactivate the feature, click the check mark next to the 
'Show tag tips' field.

1 From the Menu Bar, click Tools/Settings. 

2 Click the 'Tag Tips' tab to display options for working with tags.

Show tag tips
This field acts as a toggle to display or not display tag tips.    Click on the check mark to turn tag tips off.

Capitalize Tag Tips
Check this box if you wish for the Tag Tips to be displayed in uppercase.

Primary/Secondary browsers
HTML tags shown in the tag-tip drop down boxes during HTML editing are controlled by selections made in the primary and 
secondary browser fields on this menu.    Each browser field contains 'None' as an option. 

When more than one primary browser is selected, tags common to both browsers display in black when the tag tips box is 
displayed on the CuteHTML screen. 

To see tags for one browser specifically, select a secondary browser.    To change the secondary browser tag color, click the 
down arrow at the end of the 'Color' field and click on a new color.

Related Topic:
Using Tab Tips



Using Tag Tips

Tag Tips are HTML tag lists accessible during document creation or editing. 

To access and use Tag Tips:

1 In your HTML document, position the cursor where you want to insert an HTML tag.

2 Press the shift key plus the comma key (<).

3 From the Tag Tip drop down box, scroll down to the tag you wish to insert and double-click.    To close the tag, press the shift key 
plus the period key (>).

4 If a tag requires multiple variables, subsequent tag tip boxes will appear for selection until the tag is complete.    Insert a right 
caret at the end to close the tag.

Ex. <caption align="top">    'Caption' was selected from the first tag tip box, 'align' from the second, and 'top' from the 
third.



View Code in Browser

Use the View Code in Browser feature to see how your HTML code looks and works in the browser.

1 From the 'Tools' menu, click 'View in Browser'. or click the icon on the toolbar. 



Undo/Redo

To Undo a change

Click on 'Edit' then 'Undo'    (curved arrow pointing left) from the Menu Bar or click the 'Undo' icon on the toolbar. 

To Redo a change

Click on 'Edit' then 'Redo' (curved arrow pointing right) from the Menu Bar or click the 'Redo' icon on the toolbar. 

Note: You may click 'Undo' or 'Redo' an unlimited number of times until the change returns to the point you want
to keep. 



Using Help

The CuteHTMLhelp utility uses standard Windows® help design. You may access help topics through Contents, Index, or through 
the Find function.

1 From the Menu Bar, click on Help or click the 'Help' button available on most dialog boxes.

2 Click the 'Contents' tab to browse through topics by category.

Click the 'Index' tab to see a list of index entries (either type the word you're looking for or scroll through the list).

Click the 'Find' tab to search for words or phrases that may be contained in a Help topic.

NOTE:    Some screens have a context help icon represented by a question mark .    Click the question mark, move your cursor to 
the field in question and click on the field.    A tag explaining the field should appear.



Document Data

The Document Data screen contains data pertinent to the document currently displayed on the CuteHTML screen. 

1 From the Menu Bar, click on Tools/Document Data.

Text Size:    The total size of text contained in the document, shown in kb.
Images Size: The total size of images contained in the document, shown in kb.
Total Size: Total of text and images size, shown in kb.
Weight: Number of seconds your page will take to load based on size and modem speed.    Use the down arrow at the 

end of this field to adjust modem speed.

Images: Box containing a list of all images appearing in the document.
Anchors: Box containing a list of all anchors appearing in the document.

 



Word Wrap

Users may choose to have all text visible on the HTML screen by activating the Word Wrap feature.    The system default is no word 
wrap. 

To turn Word Wrap on:

From the Menu Bar, click on Edit/Word Wrap.    A check mark will appear indicating the feature is turned on.

To turn Word Wrap off:

From the Menu Bar, click on Edit/'Word Wrap.    The check mark will disappear indicating the feature is turned off.



HitBOX Tracker Step 5

Contact Name

The primary contact in case a problem arises.

Email address

We make every effort to protect your right to privacy. Your e-mail address will never be sold to an outside agency, nor will you be the 
victim of spamming.

E-mail is our primary source of contact with you.    You may receive all of the following:
Your HitBOX Tracker account number and customized HTML. 
Updates on any changes to the WebSideStory service.
Any pertinent information relevant to your site.

Birthday

Your birthday is necessary for verification in case you lose your password. 

Phone number (optional) 

Your phone number will not be sold or distributed to solicitors. 

Occupation 

Please choose the job that best describes your current occupation. 

Does your email reader support HTML Documents?

Most modern email readers are capable of displaying HTML properly. Select 'No' if you're not sure.

Related Topic:
HitBOX Tracker Step 6



HitBOX Tracker Step 2

Enter the name of your Web site: 

Type in the name of your site. This is the name that will appear on the HitBOX.com listing under the category you selected.    It will 
also be the name associated with your HitBOX Tracker account number. 

Site description: 

Enter a brief description of your site. This will be used on your listing and in returning search engine results. 

Is your domain registered with InterNIC?

If your domain is registered with InterNIC, select 'Yes'. Nearly all web hosting services have registered domain names.

Related Topic:
HitBOX Tracker Step 3



HitBOX Tracker Step 4

Company/Organization 

Enter the name of your company. (Optional) 

Business

Select the type of business the webpage will be used for.

Zip Code

Enter your postal zip code here.

Country

Select the country in which you reside.

Time Zone

Choose your time zone from the drop down box.

Related Topic:
HitBOX Tracker Step 5



HitBOX Tracker Step 7

Select the banner you want to display 

If you select to display a full or half-banner, you have the opportunity to swap banners with us.

Enter the URL of your banner if a half or full banner is selected:
 
Enter the full URL (Web page address) of the banner you want to exchange with WebSideStory.      Banner exchanges may occur 
only when full or half-banner displays are selected.

Related Topic:
HitBOX Tracker Step 8



HitBOX Tracker Step 3

Enter six keywords to describe your site. 

Please choose the most important and relevant keywords to describe your site. They will be used in the search engine on 
HitBOX.com.

Categorize your site: 

Choose the category that best matches the primary focus of your Web site. Your site will fall under this category on HitBOX.com.

Primary Language

Select the language your site uses.

Would you like to allow public access to your statistics on HitBOX.com?

Select 'Yes' if you want to make your statistics available to the public from HitBOX.com. Selecting 'No' will keep this information 
private.

Did you or are you using another site tracking tool?

If you have another tool to keep track of your site, click 'Yes' then select it from the list.

Related Topic:
HitBOX Tracker Step 4



HitBOX Tracker Step 6

Please select a password: 

Your password is required to access your account for information or changes. Your password must be at least four (4) characters 
long and may be changed at any time. 

How did you hear about us? 

We count on new member input to give us minimal demographic information so that we can improve, grow and develop our sites 
and service.    If your heard about us from another site or other media, please include the URL or media name. 

Do you have any comments or suggestions? 

Your suggestions and comments are always important to us. We appreciate any ideas you may have to make HitBOX.com an even 
better site. 

Related Topic:
HitBOX Tracker Step 7



HitBOX Tracker Step 8

The information you submitted will be displayed. Be sure that it is correct. If not, click 'Back' to make changes. Otherwise click 'Next'. 
Your system will connect to HitBOX and send the information.

If successful, your password and userid will be displayed. Write these down.

The HitBOX license agreement will be displayed. Click the box next to "I agree to the License Agreement" to accept the terms of the 
license agreement then click 'Finish'.



HitBOX Tracker Introduction

What is the HitBOX Tracker?

The HitBOX Tracker is more than a counter. In addition to tracking how many visitors come to your site, it will tell you where they 
come from, what equipment they are using, and much more--over 300 statistics in all. With the information provided by the HitBOX 
Tracker, you will be able to make informed decisions about your site design, client base, and marketing strategy.    It's all free and in 
real-time! 

How does it work?

At the end of the wizard, the HitBOX Tracker HTML code, including a graphic from HitBOX.com, is inserted into your page.    The 
HitBOX Tracker analyzes traffic to your site when the HitBOX.com graphic is loaded. In addition to all the free statistics that the 
HitBOX Tracker delivers, you will also receive a ranking on HitBOX.com and the opportunity to swap banners with us. This is an 
excellent way of increasing traffic to your site without putting out any advertising dollars.

How much does it cost?

It is absolutely FREE.

How do I access HitBOX?

1 From the Menu Bar, click on Tools/Online Services/Add Statistics or click the HitBOX icon on the Toolbar.

2 The HitBOX Wizard will take you through entering data for insertion into your HTML page.

Related Topic: 
HitBOX Tracker Step 1



File/Recent File

CuteHTML will remember the last several files accessed.    To open a recently accessed file, go to the Menu Bar and click on 'File' 
then click on one of the documents listed at the bottom of the drop-down menu.



Online Services

HitBox Statistics...
Use this feature to add the HitBOX Tracker to your HTML document.    The information is only entered once, then pasted in 
subsequent documents.

To set up HitBOX Tracker:

From the Menu Bar, click on Tools/Online Services/Add Statistics. 
Follow the step-by-step instructions in the HitBOX.com Wizard for building statistics code.
Statistics code will be inserted into your document at the end of the Wizard.

To insert the statistics code into subsequent HTML documents:

From the Menu Bar, click on Tools/Online Services/Paste Statistics Code.

Add goto.com search box
Selecting this option will insert HTML code into the current document. When viewed, this code will display the Goto.Com logo and a 
link to their website.

Interland Services (Web Hosting Service)
This will open up the Interland Services webpage, with information concerning their web hosting services.

Register.com (Domain Name Registration)
Opens the Register.com homepage, useful for registering a domain name.

LiveUniverse.com
Free web tools allow your web site to grow as large as any other big budget site.

Site Builder - Homepage building with you as a host.
Message Boards - The classic web community tool.
Chat - Real-time, java-based chat.
Guest Book - Gather comments, track visitors.
Mailing Lists - Start your own newsletter.
Polls - Turn visitors into voters.
Quiz - Create curiosity by quizzing.
Text Ticker - Scrolling text anywhere.
Greeting Cards - Host your own card site.

MyComputer Services
MyComputer offers several easy to use HTML tools, accessible through this menu.

Text O Matic - configure dynamic text for websites.
123counter - hit counter and statistics.
EZPolls - create polls for websites.
Guestbook - add a guestbook to any webpage.

NetMechanic Services
Links to the NetMechanic webpage, which offers many HTML tools.

HTML Toolbox - many services, such as link and spell checking.
Engine Starter - add your website to the Top 100 search engines.
GIFBot - speed up loading times of graphics.



Introduction

Overview of CuteHTML
CuteHTML is a Windows®-based HTML editor with powerful features designed to automate and simplify the process of creating and 
editing HTML documents on the Web.    The user-friendly Windows® interface, toolbar and help features make it the useful for both 
beginners and experts.    When used with CuteFTP, CuteHTML provides a seamless, total solution for creating and maintaining web 
sites. 

CuteHTML's powerful features include:

Auto-tag fill , now more powerful than ANY HTML editor on the Internet.

Auto validation using the code-for-browser settings.    Only codes compatible to browsers selected by the user will show.

Customizable color-coded HTML tags.

Multi-document tabbed interface for easy navigation.

Color and RBG to HEX converter.

Unlimited Undo and Redo commands.

Document weight feature indicating the length of time the document will take to load.

Word Wrap toggle.

Smart Anchor and Image dialogs that remember commonly used data.

Sophisticated word/paragraph Find and Replace.

Dynamic view in browser function.

Highly customizable Java script support for commonly used scripts.

Handy and customizable Code Snippet that allows you to save and reuse code.

Multiple document/folder file open and drag and drop support.

Customizable default template for new HTML documents.

Line numbering option for better code management.

Shell integration 'Edit with CuteHTML' option (now toggles).

Easy to use Bold, Italic, and Font selector for those commonly used tags.

Color fonts for easy document comprehension and layout.

View unsaved changes in browser for fast assessment of proposed changes.

Auto tagging of unsaved documents (unsaved document tabs show with red lettering--prompts to save before closing).

Support for mouse wheels.

Compact executable size, made with serious Webmasters in mind.

Plus the entire set of standard text editor features.



Code Snippets

Use the Code Snippets utility to save code from an open HTML document or paste from other applications using the Windows® 
Clipboard for retrieval into future documents.

Saving outside of CuteHTML

1 Copy code to the Windows® Clipboard.
2 From the Menu Bar, click Tools/Code snippets'.
3 Click on 'Save clipboard as snippet'.
4 Type in a name for the snippet.
5 Click 'OK'.

Saving from within CuteHTML

1 Highlight code in your CuteHTML    document.
2 From the Menu Bar, click on Tools/Code snippets.
3 Click on 'Save selection as a snippet'.
4 Type in a name for the snippet.
5 Click 'OK'.

NOTE:    For easy access, CuteHTML defaults to show saved snippet and Java code names when you click 'Code snippets' or 'Java 
scripts' on the Tools menu.    If your list of saved snippets and Java codes is too long, you may change the default to not show 
names by clicking the arrow in the 'Include in menu' box when you save.

Related Topics:
Directory Settings
Edit Copy



Java Scripts

Through the Java scripts utility, users may save Java scripts from a current HTML document or paste from other applications using 
the Windows® Clipboard for retrieval into future documents.

Saving outside of CuteHTML

1 Copy code to the Windows® Clipboard.
2 From the Tools menu, click on 'Java scripts'.
3 Click on 'Save clipboard as Java script'.
4 Type in a name for the Java script.
5 Click 'OK'.

Saving from within CuteHTML

1 Highlight code in your CuteHTML    document.
2 From the Tools menu, click on 'Java scripts'.
3 Click on 'Save selection as a Java script'.
4 Type in a name for the Java script.
5 Click 'OK'.

NOTE:    For easy access, CuteHTML defaults to show saved snippet and Java code names when you click 'Code snippets' or 'Java 
scripts' on the Tools menu.    If your list of saved snippets and Java codes is too long, you may change the default to not show 
names by clicking the arrow in the 'Include in menu' box when you save.



Using the CuteHTML Toolbar

CuteHTML combines frequently-used functions and attributes on an easy-to use Toolbar which is visible when opening the program. 
Place your cursor over any image to see the name of the function or attribute. 

Related Topics:
Toolbar
HTML Tag Tools



Navigation Pane

CuteHTML opens with the Navigation Pane in view.    Use the Navigation Pane to quickly drag files from Explorer onto the HTML 
desktop for editing. 

Parts of the Navigation Pane:

Title Bar: The title bar displays the name 'Navigation' in a colored bar, usually blue.    Use the 'X' button at the end of the 
bar to close the Navigation Pane. 

Scroll Bar: Click on the left or right arrow on the scroll bar along the bottom of the pane and drag left or right to view 
portions of files or folders hidden beyond the width of the window. 

Path: Located directly under the title bar, the path field is used to navigate to a particular folder or file.    Click the down 
arrow at the end of the field to access the directory tree.

1. Find the document you want to edit using the Navigation Pane on the left side of the HTML screen.    Multiple documents may 
be opened for editing.    (See:    Tips under Open an HTML Document for moving between documents).

2. Click and drag the document or documents onto the HTML screen.

3. Click the 'X' at the top right corner of the Navigation Pane to close it and gain full view of your HTML screen.

NOTE:    The program opens with the Navigation Pane in view.    To hide the Navigation Pane from view, click View/Navigation Pane.



Inserting Images

The Image icon located on the Toolbar inserts images with the correct syntax into your HTML document using information entered 
into dialog boxes.

General Tab:

1 From the Toolbar, click the 'Image' icon.    (represented by a page with a blue check mark).

2 On the dialog box, click the 'Browse' button to find the source of the image or type it in if you know the path.    SRC is required in 
all image tags and designates which graphic is to be displayed.      Browsers only display GIF or JPEG images.

3 Type in the width and height of your image in pixels.    These attributes will designate a fixed pixel width and height for the 
image.

Advanced Tab:

4 Click the 'Advanced' tab.

5 Type the text you wish to appear in place of the image in the 'Alt Text:' field.    This attribute displays text in place of an image 
that does not load. This attribute should be used for all important images. This can help people with image-challenged browsers 
or bad connections to navigate through your site successfully.

6 Type a number in the 'HSpace' and 'VSpace' fields.    The VSPACE attribute will place padding on the top and bottom of the 
image equal to the pixel value.The HSPACE attribute will place padding on the right and left sides of the image equal to the 
pixel value.

7 Type a number of pixels in the 'Border' field to put a border around an image that is the width of the pixel value.    This field may 
be left blank.

8 Click the down arrow at the end of the 'Align' field and select an alignment for the image. The ALIGN attribute controls the 
placement of the image on the Web page. The values "TOP" and "BOTTOM" refer to where the text will align itself after an 
image.

9 Click the 'OK' button to accept the information or 'Cancel' to exit and return to the document without adding the image. 

Drag-n-Drop
You can simply drag an image into the current HTML document to speed up editing.

1 Select an image file in the Navigation Pane.

2 Drag the image into the HTML document.

3 The image tag attributes dialog box will appear.

Click the 'View in Browser' icon to see if the image is correct in appearance, size and position.



License Agreement

GLOBALSCAPE CuteHTML VERSION 1 END-USER LICENSE AGREEMENT

IMPORTANT-READ CAREFULLY: This GlobalSCAPE End-User License Agreement ("EULA") is a legal agreement between you 
(either an individual or a single entity) and GlobalSCAPE, Inc. for the GlobalSCAPE SOFTWARE(s) identified above, which may 
include associated SOFTWARE components, media, printed materials, and "online" or electronic documentation ("SOFTWARE"). 
By installing, copying, or otherwise using the SOFTWARE, you agree to be bound by the terms of this EULA. If you do not agree to 
the terms of this EULA, do not install or use the SOFTWARE. 

1. The SOFTWARE is licensed, not sold.

2. GRANT OF LICENSE.    GlobalSCAPE grants you the right to install and use copies of the SOFTWARE on your computers as 
long as the terms of this agreement are respected.
 
3. DISTRIBUTION. You are hereby licensed to make copies of the SOFTWARE as you wish; give exact copies of the original 
SOFTWARE to anyone; and distribute the SOFTWARE in its unmodified form via electronic means (Internet, BBS's, Shareware 
distribution libraries, CD-ROMs, etc.). You may charge a distribution fee for the package, but you must not represent in any way that 
you are selling the SOFTWARE itself.

4. RESTRICTIONS.    You may not reverse engineer, decompile, or disassemble the SOFTWARE, except and only to the extent that 
such activity is expressly permitted by applicable law notwithstanding this limitation. You may not rent, lease, or lend the 
SOFTWARE. You may permanently transfer all of your rights under this EULA, provided the recipient agrees to the terms of this 
EULA. You must distribute a copy of this EULA with any copy of the SOFTWARE and anyone to whom you distribute the 
SOFTWARE is subject to this EULA.

5. SUPPORT SERVICES. GlobalSCAPE may provide you with support services related to the SOFTWARE. Use of Support 
Services is governed by the GlobalSCAPE polices and programs described in the user manual, in online documentation, and/or 
other GlobalSCAPE-provided materials, as they may be modified from time to time.    Any supplemental SOFTWARE code provided 
to you as part of the Support Services shall be considered part of the SOFTWARE and subject to the terms and conditions of this 
EULA. With respect to technical information you provide to GlobalSCAPE as part of the Support Services, GlobalSCAPE may use 
such information for its business purposes, including for product support and development. GlobalSCAPE will not utilize such 
technical information in a form that personally identifies you.

6. TERMINATION. Without prejudice to any other rights, GlobalSCAPE may terminate this EULA if you fail to comply with the terms 
and conditions of this EULA. In such event, you must destroy all copies of the SOFTWARE.

7. COPYRIGHT. The SOFTWARE is protected by United States copyright law and international treaty provisions. You acknowledge 
that no title to the intellectual property in the SOFTWARE is transferred to you. You further acknowledge that title and full ownership 
rights to the SOFTWARE will remain the exclusive property of GlobalSCAPE and you will not acquire any rights to the SOFTWARE 
except as expressly set forth in this license. You agree that any copies of the SOFTWARE will contain the same proprietary notices 
which appear on and in the SOFTWARE.

8. EXPORT RESTRICTIONS. You agree that you will not export or re-export the SOFTWARE to any country, person, entity, or end 
user subject to U.S.A. export restrictions. Restricted countries currently include, but are not necessarily limited to Cuba, Iran, Iraq, 
Libya, North Korea, Sudan, and Syria. You warrant and represent that neither the U.S.A. Bureau of Export Administration nor any 
other federal agency has suspended, revoked or denied your export privileges.

9. NO WARRANTIES. GlobalSCAPE expressly disclaims any warranty for the SOFTWARE. THE SOFTWARE AND ANY RELATED 
DOCUMENTATION IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, 
WITHOUT LIMITATION, THE IMPLIED WARRANTIES OR MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR 
NONINFRINGEMENT. THE ENTIRE RISK ARISING OUT OF USE OR PERFORMANCE OF THE SOFTWARE REMAINS WITH 
YOU.

10. NO LIABILITY FOR CONSEQUENTIAL DAMAGES. IN NO EVENT SHALL GLOBALSCAPE OR ITS SUPPLIERS BE LIABLE 
TO YOU FOR ANY CONSEQUENTIAL, SPECIAL, INCIDENTAL, OR INDIRECT DAMAGES OF ANY KIND ARISING OUT OF THE 
DELIVERY, PERFORMANCE, OR USE OF THE SOFTWARE, EVEN IF GLOBALSCAPE HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. IN NO EVENT WILL GLOBALSCAPE'S LIABILITY FOR ANY CLAIM, WHETHER IN 
CONTRACT, TORT, OR ANY OTHER THEORY OF LIABILITY, EXCEED THE LICENSE FEE PAID BY YOU, IF ANY.

11. MISCELLANEOUS. Should you have any questions concerning this EULA, or if you desire to contact GlobalSCAPE for any 
reason, please contact GlobalSCAPE by mail at: 800 Isom Road Suite 400/San Antonio/Texas/78216/USA, by telephone at: (210) 
308-8267, or by electronic mail at: support@globalscape.net.



HTML Document Window

CuteHTML opens to a default HTML template.    Part of the template is hidden by the Navigation Pane on the left side of the window. 
To gain full view of your document, click the 'X' on the Navigation Pane title bar.

Add, edit or delete code from the window and save your document.



CuteHTML License Agreement

GLOBALSCAPE CUTEHTML VERSION LE END-USER LICENSE AGREEMENT

IMPORTANT-READ CAREFULLY: This CuteHTML LE End-User License Agreement ("EULA") is a legal agreement between you 
(either an individual or a single entity) and GlobalSCAPE, Inc. for the GlobalSCAPE SOFTWARE(s) identified above, which includes 
the User's Guide, any associated SOFTWARE components, any media, any printed materials other than the User's Guide, and any 
"online" or electronic documentation ("SOFTWARE"). By installing, copying, or otherwise using the SOFTWARE, you agree to be 
bound by the terms of this EULA. If you do not agree to the terms of this EULA, do not install or use the SOFTWARE. 

1. The SOFTWARE is licensed, not sold.

2. GRANT OF LICENSE.

(a) GlobalSCAPE grants you a limited, non-exclusive, non-transferable, royalty-free license to use the executable code of the 
SOFTWARE on your computer as long as the terms of this agreement are respected.

3. REDISTRIBUTION.    You are hereby licensed to make copies of the SOFTWARE as you wish; give exact copies of the original 
SOFTWARE to anyone; and distribute the SOFTWARE in its unmodified form via electronic means (Internet, BBS's, Shareware 
distribution libraries, CD-ROMs, etc.). You may charge a distribution fee for the package, but you must not represent in any way that 
you are selling the SOFTWARE itself. Your distribution of the SOFTWARE will not entitle you to any compensation from 
GlobalSCAPE.    You must distribute a copy of this EULA with any copy of the SOFTWARE and anyone to whom you distribute the 
SOFTWARE is subject to this EULA.

4. RESTRICTIONS.    You may not reverse engineer, de-compile, or disassemble the SOFTWARE, except and only to the extent 
that such activity is expressly permitted by applicable law notwithstanding this limitation. You may not rent, lease, or lend the 
SOFTWARE. You may permanently transfer all of your rights under this EULA, provided the recipient agrees to the terms of this 
EULA.

5. SUPPORT SERVICES. GlobalSCAPE may provide you with support services related to the SOFTWARE. Use of Support 
Services is governed by the GlobalSCAPE polices and programs described in the user manual, in online documentation, and/or 
other GlobalSCAPE-provided materials, as they may be modified from time to time. Any supplemental SOFTWARE code provided to 
you as part of the Support Services shall be considered part of the SOFTWARE and subject to the terms and conditions of this 
EULA. With respect to technical information you provide to GlobalSCAPE as part of the Support Services, GlobalSCAPE may use 
such information for its business purposes, including for product support and development.

6. TERMINATION. Without prejudice to any other rights, GlobalSCAPE may terminate this EULA if you fail to comply with the terms 
and conditions of this EULA. In such event, you must destroy all copies of the SOFTWARE.

7. COPYRIGHT. The SOFTWARE is protected by United States copyright law and international treaty provisions. You acknowledge 
that no title to the intellectual property in the SOFTWARE is transferred to you. You further acknowledge that title and full ownership 
rights to the SOFTWARE will remain the exclusive property of GlobalSCAPE and you will not acquire any rights to the SOFTWARE 
except as expressly set forth in this license. You agree that any copies of the SOFTWARE will contain the same proprietary notices 
which appear on and in the SOFTWARE.

8. EXPORT RESTRICTIONS. You agree that you will not export or re-export the SOFTWARE to any country, person, entity, or end 
user subject to U.S.A. export restrictions. Restricted countries currently include, but are not necessarily limited to Cuba, Iran, Iraq, 
Libya, North Korea, Sudan, and Syria. You warrant and represent that neither the U.S.A. Bureau of Export Administration nor any 
other federal agency has suspended, revoked or denied your export privileges.

9. NO WARRANTIES. GlobalSCAPE expressly disclaims any warranty for the SOFTWARE. THE SOFTWARE AND ANY RELATED 
DOCUMENTATION IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, 
WITHOUT LIMITATION, THE IMPLIED WARRANTIES OR MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR 
NONINFRINGEMENT. THE ENTIRE RISK ARISING OUT OF USE OR PERFORMANCE OF THE SOFTWARE REMAINS WITH 
YOU.

10. LIMITATION OF LIABILITY. IN NO EVENT SHALL GLOBALSCAPE OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY 
CONSEQUENTIAL, SPECIAL, INCIDENTAL, OR INDIRECT DAMAGES OF ANY KIND ARISING OUT OF THE DELIVERY, 
PERFORMANCE, OR USE OF THE SOFTWARE, EVEN IF GLOBALSCAPE HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES. IN ANY EVENT, GLOBALSCAPE'S LIABILITY FOR ANY CLAIM, WHETHER IN CONTRACT, TORT, OR ANY 
OTHER THEORY OF LIABILITY WILL NOT EXCEED THE GREATER OF U.S.$1.00 OR LICENSE FEE PAID BY YOU.

11. U.S. GOVERNMENT RESTRICTED RIGHTS. The SOFTWARE is provided with RESTRICTED RIGHTS. Use, duplication, or 
disclosure by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of The Rights in Technical Data and 
Computer SOFTWARE clause of DFARS 252.227-7013 or subparagraphs (c)(i) and (2) of the Commercial Computer SOFTWARE-
Restricted Rights at 48 CFR 52.227-19, as applicable.    Manufacturer is GlobalSCAPE, Inc./800 Isom Road/San Antonio, 
Texas/78216/USA

12. MISCELLANEOUS. If you acquired the SOFTWARE in the United States, this EULA is governed by the laws of the state of 



Texas.    If you acquired the SOFTWARE outside of the United States, then local laws may apply.

Should you have any questions concerning this EULA, or if you desire to contact GlobalSCAPE for any reason, please contact 
GlobalSCAPE by mail at: 800 Isom Road Suite 400/San Antonio/Texas/78216/USA, by telephone at: (210) 308-8267, or by 
electronic mail at: support@globalscape.com.



Installation

System Requirements

Any PC running Windows 95/98, or Windows NT 4.0 or later.
At least 8 MB RAM and 1.5 MB of free Hard Disk space.
A connection to the Internet.

Installing

1 Turn on your computer and start Microsoft Windows 95/98, or NT4.
2 Place the installation CD in your CD-ROM drive.    Installation begins automatically.
3    Follow the on-screen instructions. 

If your CD-ROM drive does not support automatic installation, follow the steps below:

1 Place the installation CD in your CD-ROM drive.

2 Double-click on “My Computer” located on the Desktop.    Double-click on the CD-ROM drive icon.    Double-click on the 
“Setup.exe” icon.

3 Follow the on-screen instructions.

To install from download

1 Download the program.

2 Double-click the executable to run the install.

3 Follow the on-screen directions.

Uninstalling

The uninstall function removes all files associated with CuteHTML from your PC. It also removes the CuteHTML icon from your 
desktop. To uninstall CuteHTML from Windows 95/98, or NT4:

1 Click the Start button, select Settings, select Control Panel, then select Add/Remove Programs.

2 Choose CuteHTML from the list, select the Add/Remove button.

3 Follow the on-screen instructions.



Registrations and Trademarks

Copyright © 1999 by GlobalSCAPE, Inc.    All rights reserved.    CuteHTML and its logo, GlobalSCAPE and its logo are registered 
tradmarks of GlobalSCAPE, Inc.



Spelling

Select this option to start the Spell checker built into CuteHTML.

1 From the Menu Bar, click Tools/Spelling, or press the F7 key on the keyboard.

2 A questionable word will appear in the 'Not in Dictionary' field.

3 Click 'Ignore' to leave the word unchanged.

4 Type the correction in the 'Change To' field then click 'Change' to correct the spelling of a word. Selecting a word from the 
Suggestions List will enter the word into the 'Change To' field.

5 Click 'Add' to add the word to the custom dictionary.

6 Clicking 'Ignore All' or 'Change All' will correct or ignore every instance of the word in the HTML document.

7 'Options' will open the Spell Checker options dialog.

8 Click 'Cancel' to close the Spelling window.



Autocheck

Select this option from the Toolbar; click Tools/Autocheck. While enabled the Spell Checker will automatically underline words not 
found in the dictionary as you type.



Spell Checker

Spell checking options may be changed here.

1 From the Menu Bar, click Tools/Settings. 

2 Click the 'Spell Checker' tab.

3 Click 'Check Spell as you type and underline by' if you wish CuteHTML to underline words not found in the dictionary. Select the 
underline color in the drop down menu.

4 Select the language the HTML file will use from the 'Dictionary' drop down menu.

5 Select 'Use Custom Dictionary' and then click 'Edit custom dictionary' to personalize the builtin dictionary.



HitBOX Tracker Step 1

Create a New Account

Select this option if you have never used HitBOX before and want to create a new account.

Retrieve code from a recent account created on this computer

If you recently created a HitBOX account on your system and wish to use it, select the name of the account from the drop down 
menu.

Retrieve code from an existing account

An account created on another system can be used; enter your Account ID or keywords that describe your account.

Related Topic:
HitBOX Tracker Step 2



Formatting Tag Shortcuts

The following keyboard shortcuts allow for the most common HTML Formatting Tags to be inserted easily.

BOLD <B> - Ctrl + B

Italics <I> - Ctrl + I

Underline <U> - Ctrl + U

Line Break <BR> - Ctrl + Enter




